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Partner Training Team Participant Guide 
Styles Guide

This Guide is for all written materials. 
(Participant Guide, Desk Aid, Handout, etc.) 

Goals and Objectives
The developer has the option of putting appropriate objectives throughout the course when creating units/sections. These must appear in both the TN and PG when using this option. Background Information, Goals and Objectives, References:
· Title in 12 pt Bold Comic Sans font.
· Body in 12 pt, Comic Sans font.
· Indented on left and right by 5 pts, border, single line, 1 pt


If you are creating units/sections, then this is an option. Background Information, Goals and Objectives, References:
Title in 10 pt Bold Comic Sans font.
Body in 10 pt, Comic Sans font.
Indented on left and right by 5 pts, border, single line, 1 pt width


Goals and Objectives
Upon completion of this unit, the participant will be able to:
· Explain the new background check procedure.
· Identify for whom a background check needs to be completed.
· Demonstrate the background check procedure.


Purpose
The purpose of this style guide document is to standardize the layout and formatting of training materials developed within the Partner Training Team.

Objectives
Upon completion of this course, you will be able to:
Correctly format the cover and table of contents
Accurately apply heading styles to text within the document
Correctly create headers and footers on the cover page and in the body of the document
Accurately format bullets and numbers 
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Contact Information – Child Support
Contact Information
Questions regarding this training material should be directed via your local agency process to the Partner Training Team, 
Email: https://dcf.wisconsin.gov/cs/kidpol and select “Training”.
A contact person is available to answer e-mailed questions related to this training material, assist you in completing any activity that you are having difficulty with, and/or provide explanation of anything else about this training material.

Direct questions regarding Child Support cases, policy and systems should send a
KidPol via your local agency process using the same KIDPOL Request Form. 


Contact Information – W-2

Contact Information
Questions regarding this training material should be directed via your local agency process to the Partner Training Team, 
Email: PTTTrainingSupp@wisconsin.gov
A contact person is available to answer e-mailed questions related to this training material, assist you in completing any activity that you are having difficulty with, and/or provide explanation of anything else about this training material.

Questions regarding W-2 production cases and systems should be directed
via your local agency process to the BWF Work Programs Help Desk at:
Email: bwfworkprogramshd@wisconsin.gov 
Telephone: (608) 422-7900.
W-2 Policy questions should be directed to your Regional Office staff.


EEOC Statement
DCF is an equal opportunity employer and service provider. If you have a
disability and need information in an alternate format, or need it
translated to another language, please contact
(608) 535-3665 or the Wisconsin Relay Service (WRS) – 711.

[bookmark: _Toc2049278][bookmark: _Toc2055723][bookmark: _Toc380399724]For civil rights questions call (608) 422-6889 or 
the Wisconsin Relay Service (WRS) – 711.


[bookmark: _Toc494437055]Developing the Participant Guide 
Keep in mind that the Participant Guide should contain primarily space for notes and activities. 
· Provide learners the opportunity to interact with the materials, rather than providing paragraphs of information. This is more like a workbook than a policy manual.
· Provide activities, interactions, reflections, and space to take notes during discussions.
· Provide follow up to activities, videos, demos, and information the learner needs after the class.
· Document key concepts or points of the subject being taught (keep these brief and to the point).
· Provide a structured framework for activities and exercises.
· Provide blank space or add bullets/numbers as appropriate. Do not add lines. 
· Provide step-by-step instructions. 
Options for providing instruction on processes:
· Provide screen prints, allow learners to take notes. 
· Provide space to write step-by-step instruction and for fill in the blanks.
· Provide specific step-by-step instruction.
· Refer to other resources, e.g., Desk Aids, CS Fact Sheets. 
· Include course references, forms, computer images, and other resources useful in the learning of processes and procedures.
· Use appropriate headers and footers. 



· 

[bookmark: _Toc494437056]Title/Cover Pages 
· Do not apply a Heading to the Title. If you do, Word automatically pulls it into the Table of Contents and you have to manually delete it. The title of the Participant Guide is in Tahoma bold. The font size depends on the length of the title.
· Headers and footers do not appear on the cover page of the Participant Guide. Create a “next page” section break to separate the cover page from the rest of the document. Do not use the “different first page” checkbox on the Headers toolbar. Uncheck the “Link to Previous” button on the second page of your document so you can delete the header and footer text from the cover page.
· Borders above Purpose statement and below the Objectives statement should be a 2¼ single line border.
· The Purpose and Objectives box is at the bottom of the page. 
· You may insert a graphic between the title and the objectives. 
Note: Change all graphics used in the Participant Guide to grayscale.






Purpose
The Purpose description is a 1-2 sentence high level goal statement of the course.
2 ¼ pt single line border


Arial, 14 pt, bold

Objectives
Upon completion of this course, you will be able to:

· Write the objectives from the point of view of the participant. 
Arial, 14 pt, bulleted



[bookmark: _Toc380399725][bookmark: _Toc494437057]
 Table of Contents 
Table of ContentsHeading 4

Title/Cover Pages	3
Table of Contents	4
Contact Information Statement	5
Equal Opportunity Statement	6
Headers and Footers	7



[image: ]

Include a table of contents in all documents Participant Guides. A TOC is not necessary in Desk Aids or Pro Shop/Coach’s Corner, but may be inserted as appropriate. Correctly apply heading styles to text within the document to generate the table of contents correctly. Heading styles are described later in this document.

After the heading styles are applied, use the “References tab” to choose the “Table of Contents” button and then select “Custom Table of Contents” from the drop-down menu. In the Table of Contents dialog box, set the “Show Levels” to 3. If it makes sense to include heading 4, change the “Show Levels” setting to 4. Click “OK” to create the table of contents at your insertion point.

	[image: ]
	[image: ]



[image: ]

[image: ]
Right-click on the Table of Contents to update. Then, choose the “Update Field” option. Select “Update entire table” and click “OK in the dialog box that appears.
[bookmark: _Toc380399726][bookmark: _Toc494437058]
Contact Information Statement
All training material must include the W-2 or Child Support Contact statement. Place the statement after the table of contents. Text is Arial 12 pt with a ½ pt single line border.

Use on W-2 and Child Support materials - PGs and Independent Study

W-2 Contact Information
Questions regarding this training material should be directed via your local agency process to the Partner Training Team, 
Email: PTTTrainingSupp@wisconsin.gov
A contact person is available to answer e-mailed questions related to this training material, assist you in completing any activity that you are having difficulty with, and/or provide explanation of anything else about this training material.

Questions regarding W-2 production cases and systems should be directed
via your local agency process to the BWF Work Programs Help Desk at:
Email: bwfworkprogramshd@wisconsin.gov 
Telephone: (608) 422-7900.
W-2 Policy questions should be directed to your Regional Office staff.




Child Support Contact Information
Questions regarding this training material should be directed via your local agency process to the Partner Training Team, 
Email: https://dcf.wisconsin.gov/cs/kidpol and select “Training”.
A contact person is available to answer e-mailed questions related to this training material, assist you in completing any activity that you are having difficulty with, and/or provide explanation of anything else about this training material.

Questions regarding Child Support cases, policy and systems should
be directed via your local agency process to the KIDPOL Request Form https://dcf.wisconsin.gov/cs/kidpol 




[bookmark: _Toc2049289][bookmark: _Toc2055730][bookmark: _Toc380399727]

[bookmark: _Toc494437059]Equal Opportunity Statement
All training material must include the following statement. Place the statement after the Contact Information Statement. Text is Arial 12 pt with a ½ pt single line border.

DCF is an equal opportunity employer and service provider. If you have a
disability and need information in an alternate format, or need it
translated to another language, please contact
(608) 535-3665 or the Wisconsin Relay Service (WRS) – 711.

For civil rights questions call (608) 422-6889 or 
the Wisconsin Relay Service (WRS) – 711.


Note: Keep the Contact Information Statement and the Equal Opportunity Statement on the same page with the Table of Contents. If these statements do not both fit after the Table of Contents, move the statements to the bottom of next page and leave the rest of that page blank.
[bookmark: _Toc380399728][bookmark: _Toc494437060]
Headers

Training Program Name: Arial, 10pt, right aligned with the margin 
Example: Art of Assessment or Job Access Loans. The words “Participant Guide” are not included in the heading. If chapters, units, or sections are needed in the participant guide, the unit title goes on the 2nd line, under the program name. 
Remember, if you need chapters, units, or sections, use a “continuous” or “new page” section break. Update footers in each section when editing.




[bookmark: _Toc2049277][bookmark: _Toc2055722]


[bookmark: _Toc331162253][bookmark: _Toc331170880][bookmark: _Toc331170921][bookmark: _Toc331171297]
[image: ]



	Use the “Borders and Shading” button in the Paragraph section of the “Home” tab to create the border under the header. Select “Borders and Shading” from the shortcut menu to display the Borders and Shading dialog box. Select the style with the heavier line over the thinner line, the width of 1½ pt, and select the icon showing the line being drawn under the text. Click “OK.”

	[image: ]





[bookmark: _Toc494437061]Footers
[image: Graphical user interface, application

Description automatically generated]

Select the double line style to create the border above the footer, the width of ¾ pt, and selecting the icon showing the line drawn over the text. Click “OK.”

The file name of the document matches the name in the footer path.
The first line of the footer is Arial 10 pt, font. The second line is Arial 8 pt, font. 






DO NOT use the “Date & Time” button or “Insert” tab to insert the date in the footer. This shows the current date rather than the last date the document was edited.




Click the “Page Number” button on the “Header and Footer Tools” tab (not from the Insert tab) to insert the page field in the footer. Check the placement of the page number. Center the Page numbers in the footer (center tabbed 3¼).


[image: ]
[bookmark: _Toc2049279][bookmark: _Toc2055724][bookmark: _Toc380399729][bookmark: _Toc494437062]
Fonts and Margins
[image: ]When using Microsoft Word to develop curricula (or portions of a curriculum), use:
Body Text	Arial, 12 pt, left justified
Margins	1” (top, bottom, left, right)
Header	 .5”
Footer	 .67”


NOTE: Once the margins, header and footer are set correctly, click the “Set As Default” button to make these settings the default for all new/blank documents you create.













[bookmark: _Toc2049280][bookmark: _Toc2055725][bookmark: _Toc380399730][bookmark: _Toc494437063]Example Boxes
Example
Use the Example Box style to correctly format examples. Example boxes use Comic Sans 12 pt font with a single line border. They are indented ½ inch on both sides. Consider numbering the examples if there are a lot of them in the document.

If using bullets or numbering in an example box, apply the Example Box style first, apply the bullets or numbering to the text within the example and then adjust the Left Indent marker as necessary. For more information, see the Techtip on formatting bullets/numbering in example boxes.
[bookmark: _Toc2049281][bookmark: _Toc2055726][bookmark: _Toc380399731][bookmark: _Toc494437064]
CARES Screen Captures
Use the Screen Print style (Courier New 9pt with1 point single line border) when formatting CARES screens. Note: Use Virtel (Mainframe Host) to capture CARES Mainframe screens. 
[bookmark: _Toc2049282]CARES Screen Name (Ex: Selection Screen)
	07/02/99  10:38:58    SELECTION SCREEN (USSMSG10)          VTAM: L0CWI57A     
                                                                                
                                                                                
                                                                                
                CBT1                                                            
                                                                                
                CICSBP        CICSDP        CICSDP24                            
                CICSFP3       CICSFP4       CICSHP        CICSP330              
                                                                                
                EOSP          FH                                                
                IBM           IMAGE         IMSBP         IMSFP                 
                                                                                
                MENUMGR                     REFRESH       TSO                   
                WISMART                                                         Use Comic Sans MS 10pt font for text in the callout box.


                                                                                
                                                                                
                                                                                
THIS SYSTEM IS FOR AUTHORIZED USERS ONLY; SYSTEM ACCESS IS MONITORED.  BY USING 
THIS SYSTEM YOU EXPRESSLY CONSENT TO THIS MONITORING.  EVIDENCE OF UNAUTHORIZED 
ACCESS WILL BE PROVIDED TO THE APPROPRIATE LAW ENFORCEMENT AGENCIES.            
                                                                                
ENTER SELECTION HERE:                                                         

NEXT TRAN: _____          PARMS: ___________________________________________



When discussing multiple areas of the screen, don’t use callouts. Use the insert tab to choose a symbol from the Wingdings list (, , , etc.) and then list the descriptions below the screen capture. 
Screen captures need to be in a logical order with consistent case information throughout all screens.
When referencing Mainframe screen names, fields, menus, buttons, etc. use the following formatting:
· Use carats to reference keyboard commands - <PF24>, <Tab>, <Enter>, etc.
· When referencing CARES screens, always write out CARES screen before the TRAN code the first time it is referenced in the section. Thereafter, just use the TRAN code. 
· When referencing a field on a CARES screen, write the field name and field entry in all caps as they display on the screen. 
· Always capitalize when referencing PARMS. 
[bookmark: _Toc67215287][bookmark: _Toc494437065][bookmark: _Toc380399732][bookmark: _Toc2049290][bookmark: _Toc2055731]
KIDS Screen Captures
Income Withholding Summary (IWA) screen
 KATIWA    XKT100                   K I D S                VTCC1SXC             
 06/21/14  15:33:27        INCOME WITHHOLDING SUMMARY                           
 NCP: FLINTSTONE           FRED              PIN: 0000006986 IV-D #: 0000006990 
 CP:  FLINTSTONE           WILMA             PIN: 0000006988 WRKR #: XBY010     
 COURT CASE #: 0596FA001000	                WCIS #: 40101   DIVORCE           
 IW STAT  INAC  TYPE  I___                                                      
 UI BENEFITS:                                                                   
                                             G/L        G/                      
  SUPPORT   FREQ     AMOUNT      PERCENT    AMOUNT      L                       
                                                                                
  CURRENT   WKLY        150.00   ______   ___________   _                       
  PAST DUE  MNTH         25.00   ______   ___________   _  12 WKS+ (Y/N) Y      
  MEDICAL                        ______   ___________   _                       
  PAST MED  ____   ___________   ______   ___________   _                       
  SPOUSAL   ____   ___________   ______   ___________   _                       
  OTHER     ____   ___________   ______   ___________   _  DESC: _______________
                                                                                
  TOTAL:    WKLY        155.76                                                  
                                                                        NOTES: N
 CREATED: 01/24/2011         LAST UPDATED: 06/21/2013        BY WORKER: XKT126  
 ------------------------------------------------------------------------------ 
                                                                                
 F1-HELP         F2-JUMP-SAVE    F3-MAIN MENU    F4-SUB MENU     F5-NOTES       
 F11-CONFIRM     F12-CANCEL      F13-IW PROVISIO F14-JUMP-ERASE
Path: 03, 12, IV-D 
The correct format for a KIDS screen path uses two-digit numbers (include zeroes) and is separated by commas and spaces (ex: 02, 02, 07).
· Use carats to reference keyboard commands - <PF24>, <Tab>, <Enter>, etc.
· Example: 
· Add the Assistance case number on the Update Case (C8C) screen (Path: 01, 02+F16 on C1B).
· Use symbols such as      next to the fields to refer participants to field narratives.
· List screen prints in a logical order with consistent case information throughout all screens.
· Use call out boxes found in the Shapes button on your Insert Tab to highlight certain areas on the screen print.  

Field definitions are done in tables.

	Field Definitions

	Freq
	The income withholding frequency.


	Amount
	The amount of income withheld.




	The Partner Training Team Participant Guide Styles Guide
The table borders can be changed to “no border” so that the black lines do not appear.
DFES/Partner Training Team	24	04/16/24
S:\\Admin\TrainingDev\StyleGuides\Participant_Guide_Styles\pg-style-guide_041624.docx
[bookmark: _Toc494437066]Internet Based Systems Screen Captures 
Use Print Screen to open Greenshot and capture the screen. Select an area a little bigger (about ¼”) if it is a partial image of the page. 
· Ensure the cursor/arrow is not in the screen capture area. 
· If not using torn edges – Copy to Clipboard and paste in your document. 
· If using Torn Edges (partial image of a page) 
1. Open in Greenshot. 
2. Apply Torn Edges effect. 
3. Crop to preserve only the needed torn edge. 
4. Save and Insert Picture in document. 

[image: ]
When referencing internet based system screen names, fields, menus, buttons, etc., use the following formatting:
· Bold: page name, section heading field name, navigation menu option
· Title Case: Title Case: proper nouns, links, tabs, radio, check boxes, and command buttons (the yes/no, delete, save, etc. all count as command buttons)
· All Caps: Field Entries, including drop-down box choices
· Quotes: Put any page question in quotes ("Are you currently employed?")
· Italicize: Entries for the Details field, Notes field, or Case Comments
[bookmark: _Toc494437067]Heading Styles
Heading styles are as follows:

[bookmark: _Toc365451958][bookmark: _Toc365452309][bookmark: _Toc380073868][bookmark: _Toc1960045][bookmark: _Toc1960079][bookmark: _Toc2049285][bookmark: _Toc2055728]Heading 1: Tahoma, 24 pt, Bold
[bookmark: _Toc365451959][bookmark: _Toc365452310][bookmark: _Toc380073869]Heading 2: Tahoma, 20 pt, Bold, 1 ½ pt line
[bookmark: _Toc1960046][bookmark: _Toc1960080][bookmark: _Toc2049286][bookmark: _Toc2055729][bookmark: _Toc365451960][bookmark: _Toc365452311][bookmark: _Toc380073870]Heading 3: Tahoma, 18 pt, BoldRemember, with the exception of Heading 1, the heading styles have a space included below the text. Do not put extra space after a heading.

[bookmark: _Toc2049287]Heading 4: Tahoma, Bold, 14 pt, Bold
[bookmark: _Toc2049288]Heading 5: Tahoma, 14pt, Bold Italic




[bookmark: _Toc380073871][bookmark: _Toc380399733][bookmark: _Toc494437068]Bulleted and Numbered Lists
	Bullet standards are as follows:
	Number standards are as follows:

	First Level
Second Level
Third Level
	First Level
Second Level
Third Level



Notes:
· Be aware of punctuation when you use bulleted or numbered lists. Use a period at the end of each bullet if the items are complete sentences. Otherwise, use semi-colons and the second to last bulleted item must have the word and or or after it followed by no punctuation. A period follows the last bulleted item.
· Capitalize listed items.
· Bulleted lists are left justified. Select the bulleted lines and then drag the Left Indent marker on the ruler bar so it lines up with the left margin.
· Numbers are indented from the left margin as illustrated above. 
· When numbering a list of items, use the Numbering tool on the Home tab. Do not type the number manually.
· It is acceptable to vary from the bulleted or numbered style if there is a business reason to do so (e.g. a checklist that you want to use checkmarks as the bullets).

[bookmark: _Toc380073872][bookmark: _Toc380399734][bookmark: _Toc494437069]Appendix Standards
· Use a Cover page/Title page for the Appendix section. Use the Heading 1 style.
· Label each Appendix “Appendix [A, B, etc.] - Title of document” (e.g. Appendix A – W-2 Acronyms). Use the Heading 2 style.

[bookmark: _Toc380073873][bookmark: _Toc380399735][bookmark: _Toc494437070]

Graphics
Required
[image: ]Reference: Good Cause and Noncooperation Fact Sheet 
OR 
See the Income Withholding Fact Sheet on the Child Support Resource Page. 



Optional 
[image: ]
[image: ][image: ]


Tidbits to Remember
[bookmark: _Toc494437071]General
· Use one space between sentences, not two spaces.
· Capitalize Case Manager.
· Program names (W-2, Child Support, Child Care) are capitalized when referring to the program, however when referring to the benefits the terms are not capitalized. 
· “When a W-2 participant needs child care, he or she is referred to the Child Care program.”
· Child Care is always two words.
· Capitalize Participant Guide.
· Two-parent household has a hyphen.
· Use “he or she” and “his or her.” Don’t use a slash (/).
· Always place a comma after the second to last item in a list. For example, “She took a photograph of her parents, the president, and the vice president.”
· No space between hyphenated words (e.g. Up-Front) unless the hyphen is being used in place of a colon (e.g., NWT Completion – Resource Specialist).
· No space before or after a slash (e.g., and/or).
· When writing out DCF’s title, do not use an ampersand (&).
· Department of Children and Families
· Nouns and modifiers/pronouns must agree in number (singular vs plural). 
· “The FEP should verify his or her…”  - Correct
· “The FEP should verify their…” - Incorrect.
· When a policy refers to a timeframe that is a specific number of days, there must be an indicator as to whether they are working days or calendar days. Do not use business days.
· Use the active voice whenever possible.
· Write DCF, not The DCF. 
· Spell out only single digit numbers (one through nine) and use numerals for all others (10+), unless the numbers are within the same category. 
· “I have had responses from 3 of the 18 people I invited.” 
· If a particular style or direction is not listed in here or in the BWF Style Guide, be consistent within the document.



[bookmark: _Toc494437072]W-2
· The abbreviation for Wisconsin Works in training materials is W-2 (not W2).
Note: However, W2 is used in the filename.
· When a policy refers to applicants and participants, write out and or or. Don’t use a slash (/).
· Use W-2 Group when you are writing policy. Use W-2 Assistance Group when you are writing CARES instructions.
· Identify who is required to perform the action. Use FEP when it's the FEP, RS when it’s the Resource Specialist and W-2 agency when policy doesn’t define who performs the action. Don’t use the ambiguous term: Worker.
· When referring to a policy in another section of the W-2 Manual, use the word “See” followed by the section number. Enclose the reference in parentheses. Make section number a link. For example, “During the application process, the FEP may also refer the applicant for vocational evaluation or formal assessment of employment barriers. (See 5.5.1)”
· When referring to W-2 Operations Memos, Administrators Memos, or Policy manuals, use the following naming conventions:
· BWF Operations Memo XX-XX
· DFES Administrators Memo XX-XX
· W-2 Policy Manual X.X.X
· When referring websites/systems, use "in" when referring to the system as a whole (scan into ECF). Use "on" when referring to a page or screen within the system (enter comments on CARES screen CMCC).
[bookmark: _Toc494437073]
Child Support
· When referring to Child Support policy documents, use the following naming conventions:
· Child Support Bulletin XX-XX
· Child Support Letter XX-XX
· DFES Administrators Memo XX-XX
· BCS Manuals (Forms and Documents, Events and Worklists, Reports, SDU Handbook, Child Support Policy) 
· References to Fact Sheets do not need to include Child Support. The reference is the name of the Fact Sheet (e.g. The Distribution Hierarchy Fact Sheet). 
· Refer to the Child Support Partner Resources website (or site) to help distinguish it from references to specific resource pages.
· Refer to resource pages on the Child Support Partner Resources website by the name of the page and a reference to the website (e.g. Health Insurance Resource Page on the Child Support Partner Resources website). If it’s a second reference, it’s acceptable to write Health Insurance Resource Page on the CSPR website.
· Child Support Online Services website. In the first reference use the full name. For second references, CSOS website is acceptable.
· KIDPOL is not an email address any more. Refer to it as the KIDPOL Request Form with the website: https://dcf.wisconsin.gov/cs/kidpol. Instruct workers to submit a KIDPOL request using this website.


[bookmark: _Toc1960003][bookmark: _Toc1960044][bookmark: _Toc1960078][bookmark: _Toc2049284][bookmark: _Toc2055727]
[bookmark: _Toc494437074][bookmark: _Toc380073874][bookmark: _Toc380399736]
Child Support Standard Formatting
Child Support
Capitalize Child Support Program when it is specific to the program or aspects of the program; lower case child support or child support program when used generically. 

Examples: 
· The Child Support Program in WI provides services to both custodial and non-custodial parents. 
· Every state administers a child support program.

Child Support Agency 
Capitalize Child Support Agency when it is specific to the agency; lowercase child support agency when used generically. 

Examples: 
· The Child Support Agency is responsible for providing services to parents. 
· Every county and tribe in WI has a child support agency. 

Child Support Fact Sheet 
Capitalize Fact Sheet when referring to a specific fact sheet; Lowercase when discussing fact sheets in general.

Examples: 
· The Case Initiation Fact Sheet is available on the CSRP. 
· Multiple fact sheets are available on the CSRP. 

Manual 
Capitalize Manual when referring to a specific manual; lowercase when speaking generically. 

Examples: 
· Refer to the Child Support Policy Manual Administrative Account Seizure for more information. 
· All manuals related to the Child Support Program are found on the CSRP. 

Case Manager 
Capitalize Case Manager when referring to a specific job function; lowercase when used generically. 

Examples: 
· The Case Manager should develop a good rapport with customers. 
· In order to provide good case management, a worker must return call promptly.

Worker
Typically, use a lowercase worker. 

IV-A/IV-E
Use IV-A/IV-E when referring to other program cooperation or data exchanges to include W-2, IM and Child Welfare. 

Terminology Changes 
Intergovernmental
Use Intergovernmental when discussing that part of the program, use the title on the KIDS screen as appropriate (generally “Interstate”).

Substitute Care
Use Substitute Care when discussing the relevant programs. Foster Care still appears in fact sheets, etc. but it is no longer the correct term. 

Unemployment Insurance (UI)
Unemployment Insurance is the new term. Unemployment Compensation (UC) is still in KIDS and fact sheets. 

Payer
Use “payer” when discussing or referring to payers, use the title on the KIDS screen as appropriate (generally “Payor”). 

Websites/Systems
“in” KIDS
“on” CSPR

Screen Prints
Printed Materials
· Use standard style from Style Guide for printed screen prints (black & white)
· All fonts capitalized (the way the screen appears after entering the data)

CBT or PPT 
· Copy the picture and save it as a .jpg OR copy text to a black background and apply colors according to screen print defaults to a PPT (this option makes the text editable)
· The screen should appear as it does when you access it – capitalization when KIDS has it capitalized, lower case when entering text (e.g., in a demonstration). 
· After <F11>, KIDS changes all text to capitalized and this is the final screen that should display. 

NonIV-D or nonIV-D, the hyphen is in “IV-D”. 



Payment or Collection
Use payment when referring to the payer. Use Collection when referring to money received and moving though KIDS. 
Examples: 
	John mailed a payer paid payment to the Trust Fund. 
	The collection is ready for disbursement. 

Debt or Obligation
Use debt when referring to the actual amount owed in KIDS. A payer has an obligation to pay CSUP. 
	The CSUP debt at start of month is $100.00. 
	John’s CSUP obligation is $100.00 per month .

Trust Fund
State the full name once, Wisconsin Support Collections Trust Fund. Then use Trust Fund after that. 

Clerk of Court (no “s” on the end)


[bookmark: _Toc494437075][bookmark: _Hlk130463109]Filename Standards/Conventions 
As a Partner Training Team curriculum writer or training materials developer, it is important to remember the standards for naming files. All Dry Run, Train the Trainer, and final product files use the following PTT filename convention standards:

1. Filenames never contain spaces. If you want to separate a title in the filename, use an underscore.
· CS_Essentials_PG_120722
· W2CM_You_Virtual_TN_083022

2. Dates are used as part of the filename to help keep multiple versions of the training materials organized. The six digit date (MMDDYY) appears at the end of the filename, and separated from the title by an underscore.

3. Do not use special characters (e.g. “+”, “$”, “()”) in the filename, with the exception of the underscore. Only use alphanumeric characters (e.g. a-z, 0-9). Note: W-2 appears in a filename written as W2.
· W2_Final_Assess_FEP_010523.cptx

4. Code abbreviations used for curriculum documents:
· PG – Participant Guide
· TN – Trainer’s Notes
· PMT – Project Management Tool
· HO – Handout
· WB – Workbook
· DA – Desk Aid

5. The S:\ Drive Directory Paths are standardized as follows:
S:\...\Program Name\Project or course name\Title of document_code abbreviation_mmddyy. Remember to put the code at the end as shown below.

S:\...\ECM\Justice_Involved\Justice_Involved_Webinar_PG_112321.pdf
S:\...\ECM\Justice_Involved\Justice_Involved_Webinar_TN_112321.pdf

6. Store all final draft materials (documents for review, edited documents from policy reviewers, Dry Run, Train the Trainer, etc.) in the appropriate S:\ drive Curriculum folder.

7. The path name is identified when the PMT is developed.

8. Final versions of NWT and ECM course materials are published to the Trainer’s Curriculum website.
[bookmark: _Toc380073875][bookmark: _Toc380399737][bookmark: _Toc494437076]
PTT Citation Standards
The Basics
· For one to two authors use all names in every citation
· For three to five authors use all names in the first citation and then the first author followed by et.al, in subsequent citations
· For six or more authors use the first author followed by et.al, in all citations
· Titles of books and reports are italicized and titles of chapters, articles and web pages are in “quotation marks”
· For more information go to http://owl.english.purdue.edu/owl/resource/560/01/ 

Short Quotes
According to Jones (1998), "Students often had difficulty using APA style, especially when it was their first time" (p. 199). 

She stated, "Students often had difficulty using APA style" (Jones, 1998, p. 199), but she did not offer an explanation as to why.

Long Quotes – 40 or more words
Farr (2004) says the following about job clusters:
There are a variety of organizational systems that group jobs based on interests, type of job, personality type, and other factors. The better systems make it easy to identify a variety of specific job titles that most closely match your interests and abilities (p. 297).

Summary or Paraphrase
According to Jones (1998), APA style is a difficult citation format for first-time learners.

No Author
A similar study was done of students learning to format research papers ("Using APA," 2001).

Organization as an Author
According to the American Psychological Association (2000).

Unknown Author and Unknown Date
Another study of students and research decisions discovered that students succeeded with tutoring ("Tutoring and APA," n.d.)

Personal Communication
A. P. Smith also claimed that many of her students had difficulties with APA style (personal communication, November 3, 2002).
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Single Author
Berndt, T. J. (2002). Friendship quality and social development. Current Directions in Psychological Science, 11, 7-10.

Two or More Authors
Kernis, M. H., Cornell, D. P., Sun, C. R., Berry, A., Harlow, T., & Bach, J. S. (1993). There's more to self-esteem than whether it is high or low: The importance of stability of self-esteem. Journal of Personality and Social Psychology, 65, 1190-1204.

Format for Books
Calfee, R. C., & Valencia, R. R. (1991). APA guide to preparing manuscripts for journal publication. Washington, DC: American Psychological Association.

Government Document
National Institute of Mental Health. (1990). Clinical training in serious mental illness (DHHS Publication No. ADM 90-1679). Washington, DC: U.S. Government Printing Office.

Report from Private Organization
American Psychiatric Association. (2000). Practice guidelines for the treatment of patients with eating disorders (2nd ed.). Washington, DC: Author.

Conference Proceedings
Schnase, J. L., & Cunnius, E. L. (Eds.). (1995). Proceedings from CSCL '95: The First International Conference on Computer Support for Collaborative Learning. Mahwah, NJ: Erlbaum.

Web Document/Web Page
Angeli, E., Wagner, J., Lawrick, E., Moore, K., Anderson, M., Soderland, L., & Brizee, A. (2010, May 5). General format. Retrieved from http://owl.english.purdue.edu/owl/resource/560/01/

Newspaper
Parker-Pope, T. (2008, May 6). Psychiatry handbook linked to drug industry. The New York Times. Retrieved from http://well.blogs.nytimes.com
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